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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce
chapitre. Pour une liste plus détaillée, voyez dans 'Aide.

Windows/Linux Equivalent Mac Effet

Sélection de menu LibreOffice > Préférences Acces aux options de paramétrage
Outils > Options

Clic droit 3 +clic Ouvre un menu contextuel
Ctrl (Contréle) 3 (Commande) Utilisé avec d'autres touches
F5 Maj+38+F5 Ouvre le Navigateur

F11 F+T Ouvre la fenétre Styles & Formatage
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Introduction

Draw est un outil de dessin vectoriel, qui peut également effectuer des opérations sur des images
matricielles (pixels). Avec Draw, vous pouvez réaliser rapidement une grande variété d'images
graphiques.

Un outil de dessin vectoriel permet de stocker et d'afficher un graphique en tant qu'ensemble
d'éléments géométriques simples, comme des lignes, des cercles et des polygones, plutdt qu'un
ensemble de pixels (éléments d'images ou points a I'écran). Ceci permet un stockage plus simple
et un dimensionnement plus précis des éléments du graphique.

Draw est complétement intégré a la suite LibreOffice, ce qui permet de simplifier les échanges de
dessins vectoriels avec tous les composants de la suite. Par exemple, si vous créez un dessin
dans Draw et que vous voulez I'utiliser dans un document Writer, il vous suffit de le copier et de le
coller. Vous pouvez également travailler sur des dessins directement dans Writer ou dans Impress
en utilisant un sous-ensemble de fonctions et d'outils de Draw.

Les fonctionnalités de Draw sont tres completes et, bien gu'il n‘ait pas été concu pour rivaliser avec
des applications graphiques spécialisées, il possede néanmoins plus de fonctions que les outils de
dessin habituellement intégrés dans les suites bureautiques.

On peut citer de maniére non exhaustive parmi les fonctions de dessin la gestion de couches, un
systeme complet de points magnétiques, le tracé de cotations associatives, des connecteurs
facilitant la réalisation d'organigrammes, des fonctions 3D permettant de réaliser de petits dessins
tridimensionnels (avec entre autres la gestion des textures et des éclairages), l'intégration de
styles de dessin et de pages et le tracé de courbes de Bézier.

Ce Guide Draw n'est pas un cours que vous devez parcourir du début a la fin. Il s'agit surtout d'un
ouvrage de référence que vous pouvez parcourir pour une aide sur des points particuliers.

Ce document ne décrit que les fonctions associées a Draw. Certains concepts, comme la gestion
de fichiers ou I'environnement de travail de LibreOffice, ne sont mentionnés que brievement. lls
sont couverts plus en détail dans le Guide du Débutant.

Espace de travail

Les principaux composants de l'espace de travail de Draw sont indiqués Figure 1.

La grande zone au centre de la fenétre est I'endroit ou vous faites vos dessins. Vous pouvez
disposer autour de cette zone de dessin des barres d'outils et des zones d'information. Le nombre
et la position des outils visibles varient selon la tdche en cours et les préférences de I'utilisateur.
Par conséquent, votre disposition peut étre différente. Par exemple, certains utilisateurs disposent
la barre d'outils Dessin sur le c6té gauche de l'espace de travail et non en bas comme Figure 1.

Vous pouvez répartir les dessins de Draw sur plusieurs pages. Les dessins multi-pages sont
principalement utilisés pour les présentations. Le volet Pages, du cété gauche de I'espace de
travail de Draw dans la Figure 1, vous donne une vue générale des pages que vous avez créées.
Si le volet Pages n'est pas visible, vous pouvez l'activer avec la commande Affichage > Volet
page de la barre de menus. Pour modifier I'ordre des pages, cliquez et faites glisser les pages que
vous souhaitez.

Dans LibreOffice Draw, la taille maximum d'une page est de 300 x 300 cm.

Le volet latéral permet d'accéder a un certain nombre d'informations. Les icones situées le plus a
droite permettent de choisir d'afficher les Propriétés de la sélection en cours, les Styles et
formatage, la Gallery ou bien encore le Navigateur.

Pour que le volet latéral s'affiche, il est nécessaire que l'option Activer le volet latéral expérimental
(au redémarrage) de Outils > Options > LibreOffice > Avancé soit cochée. Cette fonctionnalité
étant expérimentale pour cette version, elle ne sera pas détaillée dans ce guide.
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Figure 1 : Espace de travail Draw

Régles

Vous pouvez voir les régles (des barres avec des nombres) en haut et a gauche de la zone de
dessin de Draw. Si elles ne sont pas visibles, vous pouvez les activer en sélectionnant Affichage >
Reégle depuis la barre de menus.

Les regles montrent la taille de l'objet sélectionné sur la page au moyen de lignes doubles
(entourées en rouge dans la Figure 2). Elles montrent également avec des lignes simples
(entourées en vert dans la Figure 2) la position du curseur de la souris, ce qui aide a positionner
les objets de dessin plus précisément.

Vous pouvez également utiliser les régles pour manipuler les poignées des objets et les lignes de
capture. Vous pouvez ainsi cliquer et faire glisser une ligne double pour modifier la taille de I'objet
sélectionné.

Les marges de la page sont indiquées par une zone grisée a l'intérieur des régles. Vous pouvez
modifier les marges directement dans les régles en les cliquant et les faisant glisser avec la souris.

La position par défaut du zéro pour chacune des régles est située dans le coin supérieur gauche
de la page, apres les marges gauche et supérieure (voir Figure 2). Cette position du zéro peut étre
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modifiée en cliquant sur I'endroit ol les régles horizontale et verticale se rejoignent (1-) et en
faisant glisser jusqu'a la position désirée.
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Figure 2 : Régles

Pour modifier I'unité de mesure, faites un clic droit sur la régle désirée, comme Figure 3. Vous
pouvez modifier les unités de mesure de chacune des regles indépendamment I'une de l'autre.

J_J_ |I ¥ 12 1.4 1 5

Millimetre
v Centimétre

Metre
Eilométre
Pouce
Pied
Miles
Paoint
Pica
Car
Trait

Figure 3 : Unités de mesure
des régles

Grille et guides de dessin

Draw dispose d'une grille et de lignes de capture pour assister le dessin. Elles peuvent étre

activées et désactivées en cliquant sur les boutons Afficher la grille i et Afficher les lignes de

capture +— de la barre d'outils Options. Les points de la grille et les lignes de capture sont affichés
uniquement a I'écran et ne sont pas imprimés, ni visibles quand le dessin est utilisé dans un autre
composant de LibreOffice. La couleur, la résolution et la finesse de la grille de points peuvent étre
individualisées pour chaque axe. Ceci est détaillé dans le Chapitre 3 (Manipuler les objets et les
points des objets).
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Des lignes d'aide lors du déplacement peuvent étre activées ou désactivées en cliquant sur le

bouton Lignes d'aide lors du déplacement = de la barre d'outils Options. Elles permettent de
positionner I'objet plus facilement. Lorsque cette fonction est active, des paires de lignes
horizontales et verticales entourant I'objet sont affichées durant son déplacement. Ces lignes
s'étendent jusqu'aux c6tés de la zone de dessin. Cette fonction est également décrite Chapitre 3
(Manipuler les objets et les points des objets).

Draw dispose d'autres fonctions qui vous permettent de positionner les objets dans un document,
fonctions décrites Chapitre 3 (Manipuler les objets et les points des objets).

Barre d'état

La barre d'état est située au bas de la fenétre Draw et comprend plusieurs zones (Figure 4).

Modifications Signature

Zone d'information Positon  Taille d'objet  non enregistrées numérique

Y N

Forme sélectionné(e)(s) g 204 71,01 B8l k323 *

Diape 1 /1 (Mise en page) | Standard i 54%%

\

Muméro de FPourcentage
diapositve Style de page Curseur de zoom de zoom

Figure 4 : Barre d'état Draw

* Lazone d'information montre quelle action est en cours, ou quel type d'objet est
sélectionné.

* La position et |a taille d'objet affichent des informations différentes selon le fait que des
objets soient sélectionnés ou non.

Note

Si aucun objet n'est sélectionné, les nombres de la position indiquent la position
actuelle (coordonnées X et Y) du curseur de la souris.

Si un objet est sélectionné, les nombres de la position indiquent les coordonnées X et
Y du coin supérieur gauche de I'objet et les nombres de la taille indiquent sa largeur
et sa hauteur.

Si plusieurs objets sont sélectionnés, les nombres de la position indiquent les
coordonnées X et Y du coin supérieur gauche et les nombres de la taille indiquent la
taille du plus petit rectangle possible contenant I'ensemble des objets sélectionnés.
Voir Chapitre 3 (Manipuler les objets et les points des objets) pour plus d'informations.

Si un ou plusieurs objets sont sélectionnés et en cours de modification de position ou
de taille, les données s'actualisent au fur et & mesure du déplacement ou du
redimensionnement.

Si un ou plusieurs objets sont sélectionnés, un double clic sur I'une ou l'autre de ces
informations ouvre la boite de dialogue Position et taille. Voir Chapitre 4 (Modifier les
attributs des objets) pour plus d'informations.

Les nombres des positions et tailles sont exprimés dans I'unité de mesure en cours
définie dans Outils > Options > LibreOffice Draw > Général, et non dans l'unité de
mesure définie pour la regle.
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* L'icone Modifications non enregistrées ( -* ) apparait ici si des changements dans le
document n'ont pas été enregistrés. Double-cliquez sur cette icbne pour enregistrer le
document.

* L'icone Signature numérique (||-ﬁ) indique si le document a été signé numériquement ou
non. Un double clic ou un clic droit sur cette zone permet d'ouvrir la boite de dialogue
Signatures numériques. |l est nécessaire d'avoir enregistré au moins une fois un document
avant de pouvoir le signer.

* Le numéro de diapositive indique le huméro de séquence de la page de dessin en cours
et le nombre total de pages du document. Si un objet est sélectionné, le nom de la couche
dans laquelle se trouve I'objet est indiqué entre parenthéses.

* Le style de page indique quel style de diapo est utilisé. Un clic droit sur cette zone permet
de choisir parmi les styles de diapo définis. Un double clic permet d'ouvrir la boite de
dialogue Style de diapo.

* Le curseur de zoom permet de modifier le grossissement de l'affichage en glissant le
curseur sur la gauche ou la droite ou en cliquant sur les signes + et -.

* Le pourcentage de zoom affiche le niveau de zoom sous forme de pourcentage. Vous
pouvez faire un clic droit sur ce pourcentage pour sélectionner une valeur de
grossissement ou double-cliquer pour ouvrir la boite de dialogue Zoom & disposition des
pages. Voir Chapitre 3 (Manipuler les objets et les points des objets) pour plus
d'informations.

Barres d'outils

[ ) O fouw [W0 [ W @k
15 14113 1 Boutons visibles 3 Styles et formatage
Bersonnaliser la barre d'outils...
Ligne
SHIEIEnE BArE S e _ Style de fléche
Style de ligne

Elaquer |a position des barres d'outils

Fermer la barre d'outils Largeur de ligne

Couleur de ligne
Rernplissage
Style de remplissage

Ombre

Image Map

Effets
Retourner
Position et taille

Alignement

BHRF2E 009 HE E - E

Disposer

Figure 5 : Sélection des boutons visibles d'une barre d'outils
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Vous pouvez afficher ou masquer les différentes barres d'outils de Draw selon vos besoins. Pour
afficher ou masquer une barre d'outils, allez dans Affichage > Barres d'outils. Les barres d'outils
visibles ont une coche devant leur nom dans le menu qui apparait. Choisissez celles que vous
voulez afficher.

Vous pouvez également sélectionner les icones ou boutons que vous voulez voir apparaitre dans
les barres d'outils. Pour ceci, faites un clic droit sur la barre d'outils et choisissez Boutons visibles
dans le menu contextuel. Les icones ou boutons visibles sont dans un cadre. Dans I'exemple de la
Figure 5, tous les boutons sont visibles, sauf Image Map, Retourner et Position et taille. Cliquez
sur une icone pour l'afficher ou la masquer dans la barre d'outils.

Barre d'outils Standard

La barre d'outils Standard (Figure 6) est la méme pour tous les composants de LibreOffice et n'est
pas décrite en détail dans ce chapitre.

Standard v
o - (B -H = B & | A Ce ey - ih & | & S - @

Figure 6 : Barre d'outils Standard

Barre d'outils Dessin

La barre d'outils Dessin (Figure 7) est la barre d'outils la plus importante dans Draw. Elle contient
toutes les fonctions nécessaires pour dessiner différentes formes géométriques et a main levée et
les organiser dans le document. Elle est décrite en détail dans le Chapitre 2 (Dessiner des formes
élémentaires).

Dessin *
R/ E@TI¢-%->-9-@ -« E-P-%- </ ERE

Figure 7 : Barre d'outils Dessin

Barre d'outils Ligne et remplissage

La barre d'outils Ligne et remplissage (Figure 8) vous permet de modifier les propriétés d'un objet
de dessin. Les boutons et les listes déroulantes varient selon le type d'objet sélectionné. Par
exemple, pour modifier le style d'une ligne, cliquez sur les fléches vers le haut et vers le bas de
Style de ligne et choisissez le style voulu.

Les fonctions disponibles dans la barre d'outils Ligne et remplissage vous permettent de modifier
la couleur, le style et la largeur d'une ligne dessinée, ainsi que la couleur de remplissage, le style
et d'autres propriétés d'un objet. L'objet doit avoir préalablement été sélectionné par un clic de
souris. Si l'objet sélectionné est un cadre de texte, c'est la barre d'outils Formatage du texte
(Figure 9) qui s'affiche.

Ligne et remplissage w X

& = - 0,00cm = | |Z|| a |C0u|eur |ZI|:|[] El = | € - e - LT -

Figure 8 : Barre d'outils Ligne et remplissage
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Barre d'outils Formatage du texte

La barre d'outils Formatage du texte (Figure 9) ressemble beaucoup a la barre d'outils Formatage
de Writer. Une explication plus détaillée des fonctions de cette barre d'outils se trouve dans le
Chapitre 4 (Modifier les attributs d'un objet). Pour plus d'informations sur I'ajout et le formatage des

textes, voir Chapitre 9 (Ajouter et formater un texte).

Formatage du texte

Arial v 18 [+] 6 1

s A& [=] =25

Figure 9 : Barre d'outils Formatage du texte

Barre d'outils Options

La barre d'outils Options (Figure 10) vous permet d'activer et de désactiver différentes aides au
dessin. Cette barre d'outils n'est pas affichée par défaut ; pour le faire, allez dans Affichage >
Barre d'outils > Options. Les options sont listées dans la Figure 11 et sont décrites plus en détail
dans d'autres chapitres de ce guide.

Options

&

Figure 10 : Barre d'outils Options

BHH @

i
|

i

Mode Rotation aprés clic sur 'chjet

Afficher la grille
Afficher les lignes de capture

Lignes d'aide lors du déplacement

Aligner sur la grille

Capturer aux lignes de capture
Capturer aux marges

Capturer 3 la bordure de I'objet

Capturer aux points de 'objet

Permnettre I'édition rapide
5électionner la zone de texte seule

Double-clic pour éditer du texte
Modifier I'objet avec des attributs

Quitter tous les groupes

Figure 11 : Outils disponibles dans la
barre d'outils Options
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Faire flotter et déplacer les barres d'outils

Les barres d'outils sont ancrables. Vous pouvez les déplacer, changer leurs dimensions ou les
ancrer a un coté.

Pour ancrer une barre d'outils a un c6té, faites-la glisser jusqu'a ce qu'un rectangle grisé
matérialisant sa future position apparaisse. Pour ancrer une barre d'outils a sa derniére position,
affichez son menu en effectuant un clic droit sur la barre, puis choisissez Ancrer la barre d'outils.
Pour supprimer l'ancrage, déplacez la barre a l'aide de la poignée située a sa gauche (Figure 12).

Poignées pour J e ~ H =

déplacer les :

barres d'outils e g - E
Figure 12 : Poignées des barres d'outils

Vous pouvez également ancrer ou détacher une barre d'outils en maintenant appuyée la touche
Ctrl et en double-cliqguant dans la barre ailleurs que sur un outil.

Plusieurs icbnes ont un petit triangle noir pointant vers le bas de leur c6té droit. Ceci indique que
cette icbne comprend plusieurs outils disponibles. Cliquez sur le triangle pour afficher I'ensemble
complet d'outils (Figure 13). Vous pouvez détacher cet ensemble d'outils pour qu'il devienne une
barre d'outils flottante. Cliquez sur la zone avec des lignes paralléles en bas de I'ensemble d'outils
(entourée en rouge Figure 13), faites-le glisser a I'endroit de I'écran que vous désirez et relachez le
bouton de la souris.

Pour ancrer une barre d'outils flottante, vous pouvez double-cliquer dans sa barre de titres ou faire
un clic droit et choisir Ancrer la barre d'outils dans le menu contextuel. Pour fermer une barre
d'outils flottante, cliquez sur la croix en haut a droite.

B e aFhE Organigramme v X

e eavw EEeCFEE

Qv ER® S PPdseaw

TS AVED QUEAA®S

RS 0 @ X9 AVEWD
/ QE o @

mwm%vﬁé

Figure 13 : Détacher et faire flotter une barre d'outils

L'icbne de ces ensembles d'outils est celle qui correspond au dernier outil que vous
avez utilisé, ce qui expligue que vous pouvez voir a I'écran autre chose que ce que

Note vous voyez dans les figures de ce guide. Elle reste en place méme une fois la barre
d'outils détachée.

Personnaliser les barres d'outils

Vous pouvez personnaliser les barres d'outils de différentes maniéres. Pour afficher ou masquer
les boutons d'une barre d'outils, voir Figure 5 page 9.

Pour ajouter des fonctions a une barre d'outils, déplacer des outils entre barres d'outils ou créer de
nouvelles barres d'outils, choisissez Affichage > Barre d'outils > Personnaliser, puis |'onglet
Barres d'outils (Figure 14). Sélectionnez la barre d'outils dans la liste déroulante. Vous pouvez
alors gérer son contenu. Voir le Guide du Débutant pour plus d'informations.

Espace de travail 12



Personnaliser

Menus |Clavier|Barres d'outils |Evénements

Barres d'outils LibreQffice Draw

Barre d'outils ’ MNouveau... ]
’ Barre d'outils |" ]
Contenu de la barre d'outils
Commandes ] &, - ’ Ajouter... ]
[ Mouveau ) —
[ Mouveau document & partir | ’ Modtiel d ]
Ouvrir... N

= Enregistrer
& Enregistrer sous...

)

Docurment par e-mail...

NEREREOEEOE

' i | P

Enregistrer dans | LibreQffice Draw |Z"

Descripticon

Charge un document spécifié par un URL saisi. Vous pouvez saisir une nouvelle URL, éditer un
URL, ou en sélectionner un & partir d'une liste, Affiche le chemin complet du document actif,

| ok || Annuler || Aide || Reinitialiser

Figure 14 : Personnaliser les barres d'outils

Choisir et définir des couleurs

Barre de couleurs

La barre de couleurs (Figure 15) affiche les couleurs de la palette en cours. Elle vous permet de
sélectionner rapidement la couleur de différents objets (lignes, zones et effets 3D) de votre
document. La premiére case du panneau correspond a invisible (pas de couleur). Si la barre de
couleurs n'apparait pas, sélectionnez Affichage > Barres d'outils > Barre de couleurs.

EIElIIIIﬂIIIZIIIDIIDI-IIDDDDIIIIIIIIII
SEEEEEEEEEER N EEEEEEEEEEOEEERCEE=

-
(=
-

Figure 15 : Barre de couleurs

Choisir et définir des couleurs
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Choisir une palette de couleurs

Vous pouvez accéder a plusieurs palettes de couleurs spécialisées dans Draw. Vous pouvez
également modifier les couleurs individuelles selon votre godt. Ceci s'effectue dans la boite de
dialogue Remplissage (Figure 16), qui apparait en choisissant Format > Remplissage depuis la

barre de menus ou en cliquant sur l'icbne Remplissage 2 de la barre d'outils Ligne et
remplissage. Dans cette boite de dialogue, cliquez sur I'onglet Couleurs.

Remplissage |3
|Remplissage|Gmbre|Tran5parence|CDu|Eur5 |Dégradé5|Hachure|Bitmaps|
Propriétés
Mam Bleu 9
Ajouter
Couleur ||:| Bleu d Izl
Table: standard
ol T T T
Il | e ] e
I ) RvB_ |~ -
S I . o Editer
HEESN..-. B
111 1 1 | I JES S
m._—l------ B 245 = Supprimer
1 = =
 |m/emmmw | |
1 111 1 1 I
| |mmjmm | |
1 el 1 el e
] -
[ Incorparer
Ok ” Annuler || Aide || Eeéinitialiser |

Figure 16 : Modifier la palette de couleurs

Pour charger une autre palette, cliquez sur le bouton Charger la liste des couleurs . La boite
de dialogue de sélection de fichiers vous demande de choisir I'une des palettes standard de
LibreOffice (fichiers avec extension *.soc). Par exemple, web.soc est une palette de couleurs
adaptée pour créer des dessins a placer dans des pages web. Ces couleurs s'afficheront
correctement sur les écrans capables d'afficher au moins 256 couleurs.

Une description plus détaillée des couleurs et de leurs options figure dans le Chapitre 10
(Techniques avancées de Draw).

Impression rapide

=

Cliquez sur l'icbne Impression rapide
défaut définie pour votre ordinateur.

pour envoyer le document entier a l'imprimante par
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Vous pouvez changer l'action de l'icbne Impression rapide pour envoyer le
document & une imprimante définie pour le document au lieu de I'imprimante par
défaut de I'ordinateur. Choisissez Outils > Options > Chargement/

Note enregistrement > Général et cochez Charger les paramétres d'impression avec
le document (comportement par défaut). Le choix d'une imprimante spécifique
pour un document se fait par Fichier > Paramétrage de lI'imprimante.

Contréler l'impression

Pour mieux controdler l'impression, utilisez la boite de dialogue Imprimer (Fichier > Imprimer ou
Ctrl+P). Cette boite de dialogue (Figure 17) comporte quatre onglets, dans lesquels vous pouvez

choisir une variété d'options, comme décrit dans les sections suivantes.

Imprimer

210mm (Ad) Général |LibreOf‘fir_e DrawlMise en pagelOptions|

X3

Imprimante

EPSON Stylus DX5000 Series
Microzoft XP5 Document Writer

‘@A +] Qé‘tEIIS

297 mm

Plage et exemplaires

@ Toutes |es pages
) Pages
) Sélection

[l Imprimer dans I'ordre inverse

1/ /1

Mombre d'exemplaires 1]

Proprigtés...

i

H Annuler H Aide

Figure 17 : Boite de dialogue Imprimer

Sélectionner les options d'impression générales

Dans l'onglet Général de la boite de dialogue Imprimer (Figure 17), vous pouvez choisir :

* [limprimante (parmi les imprimantes disponibles)

e (quelles pages imprimer, le nombre d'exemplaires, s'il faut assembler les exemplaires

multiples et s'il faut imprimer dans l'ordre inverse des pages

Sélectionnez le bouton Propriétés pour afficher une boite de dialogue spécifique a lI'imprimante ou
vous pouvez choisir parmi les options offertes par le pilote : filigranes, recto verso, qualité

d'impression, etc.

Pour n'imprimer que certaines pages, séparez les numéros par des points virgules. Pour imprimer
une plage de pages, insérez un trait d’'union entre le premier et le dernier numéro de pages. Vous
pouvez combiner des plages de pages et des pages uniques. Par exemple : 1-3 ; 6 ; 8-9
imprimera toutes les pages de 1 a 9 sauf les pages 4, 5 et 7. Vous pouvez également sélectionner
dans le document les pages que vous voulez imprimer et cocher Sélection.

Contréler I'impression
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Options d'impression

Dans l'onglet Options de la boite de dialogue Imprimer (Figure 18), vous pouvez choisir d'imprimer
dans un fichier (et non vers une imprimante), de créer un seul travail d'impression comprenant les

multiples exemplaires du document (et non un travail d'impression pour chaque copie) et d'utiliser

uniqguement le bac d'alimentation a partir des préférences de l'imprimante.

|Généra| |LibreCl’Ffice DrawlMise En page| Options |

Options

["] Créer des taches d'impression uniques pour les sorties assemblées
[] Utiliser uniquement le bac d'alimentation 3 partir des préférences de l'imprimante

[T Utiliser uniquernent |a taille du papier suivant les préférences de l'imprimante.

Figure 18 : Boite de dialogue Options d'impression

Imprimer plusieurs pages sur une seule feuille de papier

Vous pouvez imprimer plusieurs pages sur une seule feuille de papier. Pour ceci :
1) Dans la boite de dialogue Imprimer, sélectionnez 'onglet Mise en page (Figure 19).

|Généra| |Libre(}fﬁce Draw| Mise en page |Gptiﬂns|

Mise en page
i@ Pages par feuille |4 IZ| ]_ 2
Ordre 3 4

R T AT e e gauche 3 droite, puis en bas

de bas en haut, puis 2 droite

de haut en bas, puis a2 gauche

de droite a gauche, puis vers |e bas

() Brochure

Cotés des pages
Figure 19 : Imprimer plusieurs pages par feuille de papier

2) Dans la section Mise en page, sélectionnez dans la liste déroulante le nombre de pages a
imprimer par feuille de papier. L'apergu sur la droite de cette liste vous montre
I'organisation des pages au sein du document imprimé.

Si vous imprimez plus de deux pages par feuille de papier, vous pouvez choisir I'ordre dans
lequel elles seront imprimées horizontalement et verticalement dans la feuille de papier.
Les images de la Figure 19 et de la Figure 20 vous montrent la différence.

|Gér‘|éra| |Libreﬂﬁice Draw| Mise en page |[}ptions|

Mise en page
@ Pages par feuille |4 |Z| ]_ 3
COrdre u
2 4

[7] Dessiner une bor

de bas en haut, puis a droite
de haut en bas, puis & gauche
de droite a gauche, puis vers |e bas

(71 Brochure

Cotés des pages
Figure 20 : Imprimer plusieurs pages par feuille de papier

3) Vous pouvez choisir de dessiner une bordure autour de chaque page ou non.
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4)

Cliquez sur le bouton Imprimer.

Imprimer une brochure

Dans Writer, Impress et Draw, vous pouvez imprimer un document sous forme de brochure. Draw
imprime alors deux pages sur chaque coté de la feuille de facon a ce que le document puisse étre
lu comme une livre une fois le papier plié.

Planifiez votre document pour qu'il apparaisse correctement quand il sera imprimé

Astuce a la moitié de sa taille : choisissez des marges et des tailles de police appropriées,

entre autres. Vous aurez peut-étre besoin de faire plusieurs tentatives.

Imprimante recto uniquement
Pour imprimer une brochure avec une imprimante sur une seule face :

1)

2)

3)
4)
5)

6)
7

8)

9)

Choisissez Fichier > Imprimer et, dans la boite de dialogue Imprimer et I'onglet Général,
cliquez sur le bouton Propriétés pour ouvrir la boite de dialogue Propriétés de votre
imprimante. Cette boite de dialogue varie selon le modele de lI'imprimante.

Vérifiez que l'orientation de l'imprimante (portrait ou paysage) est la méme que celle de
votre document. Habituellement, cela n'a pas d'importance, mais c'est nécessaire pour
imprimer une brochure.

Validez si nécessaire et revenez a la boite de dialogue Imprimer.
Choisissez I'onglet Mise en page (Figure 19).

Cochez l'option Brochure. Dans la section C6tés des pages, choisissez Verso / pages de
gauche dans la liste déroulante (Figure 21).

@ Brochure
Ciotés des pages

Inclure :

Toutes les pages
Recto / pages de droite

Verso / pages de gauche

Figure 21 : Imprimer une brochure

Cliquez sur le bouton Imprimer.

Retirez les pages imprimées de l'imprimante, retournez-les et remettez-les dans
I'imprimante dans le bon sens pour imprimer sur la face vierge. Vous aurez peut-étre
besoin de faire plusieurs tentatives.

Choisissez Fichier > Imprimer et, dans la boite de dialogue, dans la section Cotés des
pages, choisissez Recto / pages de droite dans la liste déroulante.

Cliquez sur le bouton Imprimer.

Imprimante recto verso
Pour imprimer une brochure avec une imprimante recto verso :

1) Choisissez Fichier > Imprimer et, dans la boite de dialogue Imprimer et I'onglet Général,

2)

cliguez sur le bouton Propriétés pour ouvrir la boite de dialogue Propriétés de votre
imprimante. Cette boite de dialogue varie selon le modéle de I'imprimante.

Vérifiez que I'orientation de l'imprimante (portrait ou paysage) est la méme que celle de
votre document. Habituellement, cela n'a pas d'importance, mais c'est nécessaire pour
imprimer une brochure.

3) Ajustez les paramétres d'impression recto verso selon les caractéristiques de l'imprimante.

Contréler I'impression
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4) Validez si nécessaire et revenez a la boite de dialogue Imprimer.

5) Choisissez I'onglet Mise en page (Figure 19).

6) Cochez l'option Brochure. Dans la section C6tés des pages, choisissez Toutes les pages
dans la liste déroulante (Figure 21).

7) Cliquez sur le bouton Imprimer.

Imprimer en noir et blanc ou en niveau de gris

Vous pouvez vouloir imprimer votre document en noir et blanc ou en niveaux de gris sur une
imprimante couleur. Vous pouvez le faire a différents niveaux.

Pour modifier les paramétres au niveau de l'imprimante :

1) Choisissez Fichier > Imprimer et, dans la boite de dialogue Imprimer et 'onglet Général,
cliguez sur le bouton Propriétés pour ouvrir la boite de dialogue Propriétés de votre
imprimante. Cette boite de dialogue varie selon le modeéle de lI'imprimante.

2) Choisissez les paramétres d'impression noir et blanc ou niveaux de gris propres a votre
imprimante. Cliquez sur OK pour valider.

3) Cliquez sur le bouton Imprimer.
Pour modifier les parametres d'impression au niveau de LibreOffice :

1) Choisissez Outils > Options > LibreOffice > Impression.

2) Cochez l'option Convertir les couleurs en niveaux de gris. Cliquez sur OK pour garder les
modifications.

3) Imprimez le document.
Pour modifier les parameétres d'impression au niveau de Draw :

1) Choisissez Outils > Options > LibreOffice Draw > Impression.

2) Dans la section Qualité, cochez Niveaux de gris ou Noir et blanc. Cliquez sur OK pour
garder les modifications.

3) Imprimez le document.

Exporter en PDF

LibreOffice peut exporter les documents au format PDF (Portable Document Format). Ce format de
fichier standard est idéal pour envoyer un fichier a une autre personne qui utilise Adobe Reader ou
un autre lecteur PDF. La procédure et les boites de dialogue sont les mémes pour Writer, Calc,
Impress et Draw.

Export rapide au format PDF

—
Cliquez sur l'icéne Export direct au format PDF ™ pour exporter le document entier en utilisant
les paramétrages PDF par défaut. Vous devrez entrer le nom et I'emplacement du fichier PDF,
mais vous ne pourrez pas choisir les pages a imprimer, un taux de compression des images ou
d'autres options.

Controler le contenu et la qualité du fichier PDF

Pour mieux contréler le contenu et la qualité du fichier PDF résultant, utilisez Fichier > Exporter
au format PDF. La boite de dialogue Options PDF s'ouvre. Cette boite de dialogue comporte cing
onglets (Général, Vue initiale, Interface utilisateur, Liens et Sécurité). Effectuez les paramétrages
appropriés, puis cliqguez sur Exporter. Vous devrez alors saisir 'emplacement et le nom du fichier
PDF a créer et cliquer sur Exporter pour exporter le fichier. Voir le Guide du Débutant pour plus
d'informations.
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Exporter dans d'autres formats

LibreOffice utilise le terme "export" pour des opérations sur les fichiers qui impliquent un
changement de type de fichier. Si vous ne trouvez pas ce que vous voulez dans Fichier >
Enregistrer sous, regardez dans Fichier > Exporter. LibreOffice peut exporter des fichiers dans
les différents formats qui sont mentionnés dans la liste déroulante. Voir Chapitre 6 (Editer des
images) pour plus d'informations sur I'export des éléments graphiques.

Pour exporter un fichier dans un autre format :

1) Remplissez le nom de fichier du document exporté dans le champ Nom de fichier.
2) Choisissez le format voulu dans la liste déroulante Format de fichier.
3) Cliquez sur le bouton Exporter.

Le contenu du fichier exporté peut dépendre du ou des éléments sélectionnés
dans la page. Avec la plupart des formats d'images, seule I'image de la page en

Note cours sera exportée. Le dialogue comporte une case a cocher Sélection qui
détermine si I'export porte uniquement sur les objets graphiques sélectionnés. Si
cette case n'est pas cochée, la totalité du document est exportée.

Exporter des documents Draw en tant que pages web

Pour exporter un document Draw multi-pages en une série de pages web, choisissez Fichier >
Exporter, puis sélectionnez Document HTML en tant que type de fichier. L'assistant Export HTML
s'ouvre. Suivez-le pour créer des pages web. Si vous le souhaitez, l'assistant peut générer une
aide a la navigation pour vous aider a vous déplacer de page en page.

Envoyer des documents par e-mail

LibreOffice fournit plusieurs facons rapides et faciles pour envoyer des classeurs en tant que
pieces jointes d'un e-mail, et ce, dans le format OpenDocument (format par défaut de LibreOffice)
ou PDF.

Les documents ne peuvent étre envoyés depuis le menu de LibreOffice que si un

Note profil mail a été paramétré sur votre systeme.

Pour envoyer le document en cours dans le format OpenDocument :

1) Choisissez Fichier > Envoyer > Document par e-mail. LibreOffice ouvre votre client de
messagerie par défaut avec le document Draw (*.ODG) en tant que piéce jointe.

2) Dans votre client de messagerie, entrez le destinataire, I'objet et tout texte que vous voulez
ajouter, puis envoyez I'e-mail.

Si vous choisissez Envoyer par e-mail en PDF, LibreOffice va tout d'abord créer un fichier au
format PDF en utilisant les paramétres PDF par défaut (tels que si vous utilisiez le bouton de barre
d'outils Export direct au format PDF), puis va ouvrir votre client de messagerie avec en piéce
jointe le fichier *.PDF.

Vous pouvez envoyer un document par e-mail a plusieurs destinataires en utilisant les
fonctionnalités de votre client de messagerie ou les fonctions de I'Assistant mailing de LibreOffice
Writer pour extraire des adresses mail d'un carnet d'adresses.

Pour plus de détails, voir Chapitre 10 (Imprimer, exporter et envoyer par e-mail) du Guide du
débutant.

Envoyer des documents par e-mail 19
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